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CAUTION! READ THIS NOTICE BEFORE USING SOFTWARE

Please read the following Software License Agreement before using this software package. Using this
software indicates that you have accepted its terms and conditions.

SurvCADD XML
END-USER LICENSE AGREEMENT
FOR CARLSON SOFTWARE

IMPORTANT-READ CAREFULLY: This Carlson Software End-User License Agreement ("EULA")isa
legal agreement between you (either an individual or a single entity) and Carlson Software, Inc for the
SurvCADD software accompanying this EULA, which includes computer software and may include
associated media, printed materials, and "online" or electronic documentation ("SOFTWARE PRODUCT"
or "SOFTWARE"). By exercising your rights to make and use copies of the SOFTWARE PRODUCT, you
agree to be bound by the terms of this EULA. If you do not agree to the terms of this EULA, you may not
usethe SOFTWARE PRODUCT.

SOFTWAREPRODUCTLICENSE

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as
other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold.

1. GRANT OF LICENSE. This EULA grants you the following rights:

Applications Software. Youmay install and use one copy ofthe SOFTWARE PRODUCT, or any prior version
for the same operating system, on a SINGLE computer. The primary user of the computer on which the
SOFTWARE PRODUCT is installed may make a second copy for his or her exclusive use.

Storage/Network Use. You may also store or install a copy of the SOFTWARE PRODUCT on a storage
device, such as a network server, used only to install or run the SOFTWARE PRODUCT on your other
computers over an internal network; however, you must acquire and dedicate a license for each separate
computer on whichthe SOFTWARE PRODUCT is installed or run from the storage device. A license for the
SOFTWARE PRODUCT may not be shared or used concurrently on different computers, unless a network
license manager has been purchased from Carlson Software.

2.DESCRIPTIONOFOTHERRIGHTS AND LIMITATIONS.

Limitations on Reverse Engineering, Decompilation, and Disassembly. Y ou may not reverse engineer,
decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity is
expressly permitted by applicable law notwithstanding this limitation.

Separation of Components. The SOFTWARE PRODUCT is licensed as a single product. Its component parts
may not be separated for use on more than one computer.



Software Transfer. Y ou may permanently transfer all of your rights under this EULA, provided the recipient
agrees to the terms of this EULA.

Termination. Without prejudice to any other rights, Carlson Software may terminate this EULA if'you fail
to comply with the terms and conditions of this EULA. In such event, you must destroy all copies of the
SOFTWARE PRODUCT and all of its component parts.

3.COPYRIGHT. All title and copyrights inand to the SOFTWARE PRODUCT (including but not limited
to any images, photographs, animations, video, audio, music, text, and "applets" incorporated into the
SOFTWARE PRODUCT), the accompanying printed materials, and any copies of the SOFTWARE
PRODUCT are owned by Carlson Software or its suppliers. The SOFTWARE PRODUCT is protected by
copyright laws and international treaty provisions. Therefore, you must treat the SOFTWARE PRODUCT
like any other copyrighted material.

4.U.S.GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE PRODUCT and documentation are
provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to
restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software
clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-
Restricted Rights at 48 CFR 52.227-19, as applicable. Manufacturer is Carlson Software, 102 West Second
Street, Maysville, KY 41056

LIMITEDWARRANTY

NO WARRANTIES. Carlson Software expressly disclaims any warranty for the SOFTWARE PRODUCT.
The SOFTWARE PRODUCT and any related documentation is provided "as is" without warranty of any
kind, either express or implied, including, without limitation, the implied warranties or merchantability, fitness
for a particular purpose, or noninfringement. The entire risk arising out of use or performance of the
SOFTWARE PRODUCT remains with you.

NOLIABILITY FOR CONSEQUENTIAL DAMAGES. Inno event shall Carlson Software orits suppliers
be liable for any damages whatsoever (including, without limitation, damages for loss of business profits,
business interruption, loss of business information, or any other pecuniary loss) arising out of the use of
orinability to use this Carlson Software product, even if Carlson Software has been advised of the possibility
of such damages. Because some states/jurisdictions do not allow the exclusion or limitation of liability for
consequential or incidental damages, the above limitation may not apply to you.

MISCELLANEOUS
Ifyouacquired this product in the United States, this EULA is governed by the laws of the State of Kentucky.

If this product was acquired outside the United States, then local laws may apply.
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Introduction

SurvCADD is application software for civil engineering, surveying, GIS and mine engineering
which runs with AutoCAD. AutoCAD serves as the graphics engine and drawing editor for
SurvCADD. Essentially, SurvCADD is an extension of AutoCAD that customizes AutoCAD for
your specific discipline with additional commands and enhancements.

SurvCADD consists of the following modules: COGO-Design, DTM-Contour, Section-Profile,
Hydrology, GIS, Tsunami, Mining and Advanced Mining. These modules work inside AutoCAD
and use AutoCAD's user-interface, menus, and dialog boxes.
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SurvCADD Setup

SurvCADD Directory Structure

The figure below shows the default directory structure for SurvCADD. The EXEC, LSP, and SUP
sub-directories have files that are accessed by SurvCADD. You should never need to access these
files directly yourself. The DATA and WORK sub-directories are the user's directories.

ROOT
|—\SCADXML
— \EXEC
Executables
-Programs (.EXE,.DTA)
- \SUP
Support
- Drawing blocks (DWG)
- Menus (MNU, .MNX)
— \LSP
Lisp & ARX
-Programs (.LSP,.DLL,.ARX,.DCL)
- \DATA
User data files
- Survey files (RWS5,.CRD, etc)
- \WORK
Startup directory, user drawings
-Drawings (DWG)
~ \USER

User setup files
- Settings files (.INI)
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System Requirements

SurvCADD's system requirements are no greater than that of the AutoCAD version you are
running. See your AutoCAD installation guide for minimum system configuration. It is always
recommended that you use the highest performance PC possible. Note: SurvCADD does require
a minimum screen resolution of 800x600.

SurvCADD XML will operate with the following versions of AutoCAD:
* AutoCAD 14

* AutoCAD2000/20001/2002

* AutoCAD MapR2/R3/R4/R4.5/R5

e Land Development DesktopR2/R3

Installing SurvCADD

Please refer to the installation guide included in the SurvCADD package for the latest installation
instructions.

To complete the SurvCADD installation, start SurvCADD and complete the registration process
as explained in the following sections.

Starting AutoCAD with SurvCADD

To start SurvCADD, use that icon which was created on your desktop and in SurvCADD submenu
under Start->Programs. When you do so, AutoCAD is started with customized profile, which
contains all the setting changes necessary to run SurvCADD and prevents harmful conflicts
between SurvCADD and other AutoCAD based products. The changes in menus, toolbars and
preferences will be saved in that profile for further use.

SurvCADD Registration

Each SurvCADD is licensed for use on one workstation which must be registered. The registration
records your company name and AutoCAD serial number. To register your copy of SurvCADD,
start SurvCADD and choose "Register Now". The following dialog will appear.

Note that Carlson Software will no longer issue change keys over the telephone.
There are four registration options.
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#" Registration Wizard

Fieg. Method ||nsta|l Infa | User Info .t’-‘-.uthorizel

Regiztration Optiong
€~ Fa - Fill-in information and fax registration form [up to 48 hours)

& ntemet - Register on-ine instanthé

" Enter change key
' Renister Later

UWREGISTERED COFY, 100 calls remaining

MHeut » Exit

Fax: This method allows you to print out the required information which you then fax to Carlson
Software. The fax number is printed on the form. The change key will be faxed back to you within
72 hours.

Internet: Register automatically over the Internet. Your information is sent to a Carlson Software
server, validated and returned in just a few seconds. If you are using a dial-up connection, please
establish this connection before attempting to register.

Enter pre-authorized change key: If you originally chose the Fax method above, you will need to
choose this method now to enter the change key that is faxed back to you.

Register Later: If you wish, you may defer registration up to 30 days. After this time, SurvCADD
will enter demo mode which displays a message each time a SurvCADD command is run.

Afteryouselectthe registration method, choose Nextand review the copyright information, choose
Nextagain and select the type of installation you are performing, choose Next again and fill out the
required information. Atthis pointifyou are using the Fax method, press the Print Fax Sheet button.
If you are registering using the Internet method, press Next and the process will start.

If you have any problems with Internet registration, please repeat this process and use the Fax
method.

Tip: If SurvCADD is running, you may access the registration dialog
by choosing About SurvCADD from the Help menu, then pick the
Change Registration button.
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SurvCADD Configuration

To set SurvCADD start up defaults, choose the Configure SurvCADD command from the *File*
pull-down menu after starting SurvCADD. Configure SurvCADD allows you to set the variables
as shown below. These values are stored the files SURVCADD.INI, COGO.INI, DTM.INI,
MINE.INI, HYDRO.INI, and SCTPRO.INIin the SurvCADD USER directory

SURVCADD.INI
[spdir$=C:\SC14\LSP\
exedir$=C:\SC14\EXEC\
tmpdir$=C:\SC14\DATA\
psname=C:\SC14\SUP\
s5c_pdev=out.fil
s5c_pon=0

bearoraz=B
pntnoon=Y

autoon=Y
pnl=SRVPNO1

prpel=Y

realz=Y

corm$=E

prpds=Y

ihrhon=N

erton=0

ptemp=4

putosyb=Y

tpntno=1

usetw=Y

ignore0=1

do bezier=1

reduce offset=0.5
do_reduce=1

bezier num=>5
5v:sm=50.0

5v:vs=50.0

sv:its=0.1

sv:ps=0.1

SCTPRO.INI
offset horiz=1
tick=n
min_slope=0.010
max_len=400.000
mh_drop=0.000
axis_txt size=0.100
to_sheet=0
pvi_v=0
mh_top=2.000
mh_bottom=4.000
pipe nm=PVC
do_kval=0
do_sdist=0
do_grades=1
do_vert=0
do_below=0
eyeht=3.500
tob=0.500
veres=10
COGO.INI
bothmf=0

dsuf=’

dsuf2=m
boff=1.500
stripsp=N
radch=1.050
angnum=1
Idr_scale=0.500
Itype scale=0.500

SurvCADD Default Configuration

Itype text=0.100
draw_leaders=0
angon=0

arlab=2

squnit=1

squni2=1

MINEINI
rotate_hatch=0
hpattern=mudst
draw_hatch=1
flayer=FENCE

do layer=1

geo width=50.00
geo layer=GEOCOL
core_text=CORETEXT
core_name=1

core desc=1
core_surf=1

core strata nm=I
core_val nm=0
sdpsdir=c:/sdps/
DTM.INI
max_tmesh=10000.00
tmesh_layer=TMESH
ctr_layer=CTR

HYDRO.INI
hecdir=c:/hec/

sedcaddir=c:/sedcad/

Installation & Overview
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Tablet Template

If you have a digitizer you will probably want to plot a copy of the SurvCADD tablet menu. After
installing SurvCADD, start AutoCAD and plota copy of the drawing file TABLET.DWG located
inthe SurvCADD supportdirectory (ie:\SCADXML\SUP\TABLET.DWG), atascaleof 1=1. You
may want to review the drawing in the drawing editor to determine layer names and colors to set
up a color version of the template. You can also modify this drawing to add your own symbols and
detailsto the tabletmenu. After plotting, secure the SurvCADD template drawing to your digitizer.
The proper scale is 1=1 fora 12" x 12" tablet. It can also be plotted at a smaller or larger scale to
suit other tablet sizes.

Once you have a hardcopy of the tablet, AutoCAD needs to be configured for the tablet. Type
TABLET atthe AutoCAD command prompt. Refer to the AutoCAD Reference Manual for details
on the menu area points and number of columns and rows. The tablet template is in the standard
AutoCAD template format which means if you are using any of Autodesk’s other templates you
can easily switch between different control menus.
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Troubleshooting Setup

To install SurvCADD XML on Windows NT4.0, Windows 2000, or Windows XP, you must have
Administrator permissions to write to the system registry during the install.

Successful install of SurvCADD consists of four key items:

1. Windows registry settings

2. SurvCADD icon on desktop and in the Start menu

3. SurvCADD XML profile created in AutoCAD.

4.SurvCADD.ini configuration file in USER sub-directory of SurvCADD.

If you have trouble starting or running SurvCADD XML after installation, choose SurvCADD
Setup Wizard from the SurvCADD portion of your start menu. If you cannot find this shortcut, run
the programnamed SCWIZ15.EXE (or SCWIZ14.EXE for AutoCAD R 14) found in the SurvCADD
\EXEC folder.

If this does not fix the problem, please re-install the software making note of any possible error
messages before contacting Technical Support.

Desktop and Menu icons for SurvCADD XML

A SurvCADD specific profile is used in order to configure SurvCADD correctly and start
SurvCADD menu when AutoCAD starts. Profiles are used by AutoCAD to separate different
product environments.

The profile to use with AutoCAD is sup-
plied by the SurvCADD startup program.  |Eiaee i N e Ty Ty ey e | #] x|
To verify that your SurvCADD icon is set Gerers Shaito |
up correctly, do the following:

T SaaryTADD WML Far Frakss Al Map B
* Right-Click on the SurvCADD icon and EF

select Properties. Click on the Shortcut tab. Tl T

* Target field should contain the following Targed aoation LESER,
executable SCJSTART.EXE (locatedinthe Tepett [ CilscadnditSERIschitat e
SurvCADD\USER directory)

F - . e [ P
» Work directory defaults to the same direc- : = =
tory where drawings are stored. — [iscamreiwoes
» Make changes as needed and click OK. Shartcubken et

B fraciwasd vanediva =l

. O

EraTagt.. | chergeden. |

SurvCADD ML for
Autodesk Map A I_ﬁl . i J Ao |
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Checking SURVCADD.INI configuration file.

The last step in troubleshooting the installation is to verify the SURVCADD.INI file in the
SurvCADD USER directory. Open that file using Notepad (Click Start, Programs, Accessories,
Notepad) or any other editor. Then verify and/or modify the top few lines to match your setup. Save
itand restart SurvCADD.

If the procedures outlined above did not help or you have trouble following them, please feel free
to contact Carlson Software Tech Support.

Obtaining Technical Support

via Discussion Groups:
* Carlson Software operates user discussion groups located at news://news.carlsonsw.com. You
can participate in user-to-user discussion on tips, tricks and problems. Our staff monitors these
groups to ensure that all the issues are addressed. Visit our website at http://www.carlsonsw.com
for information on how to access these groups.

via Electronic Mail
 The Technical Support e-mail address is support@carlsonsw.com

via Phone/Fax
Please contact Technical Support at following numbers:
*Phone: (606) 564-5028
*Fax:(606) 564-6422

via Web Site:

Check the Carlson Software Web Site at http://www.carlsonsw.com for

* Technical support documents

* Frequently asked questions

« Software updates. Feel free to register for automatic update notification ofupdates when you come
to that area.
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Command Entry

Commands may be issued by selecting a pull-down menu, screen menu, digitizer tablet item, or by
typing a command at the AutoCAD command prompt. Pressing Enter at the command prompt
repeats that last command. Pull-down menus have a row of header names across the top of the
screen. Selecting one of these header names displays the possible commands under that name.
Screen menu items are shown in the screen menu (typically on the right side of the screen). The
screen menu can be toggled off and on inside of the AutoCAD Preferences dialog. The Pull-down
menus are the primary method for SurvCADD command selection. Each section of this manual
shows the pull-down menu which contains the commands that are explained in that section. Pull-
down menus are sometimes also referred to as drop-down menus.

Command availability depends on which menuisloaded. SurvCADD menus have amixture of both
SurvCADD and AutoCAD commands. This allows you to execute the commonly used AutoCAD
commands from the menus while running SurvCADD.

Quick Keys are user-defined short-cut names that can be typed in to start commands. To review
the current set of Quick Keys, run the Quick Keys command in the Misc pull-down menu.

Loading SurvCADD Modules

Loading SurvCADD or a SurvCADD module is equivalent to loading the corresponding menu in
AutoCAD. The SurvCADD menus are SC15SBASE.MNU, P-COGO15.MNU, P-DTM15.MNU, P-
SCT15.MNU,P-MAP15.MNU,P-MINS15.MNU,P-HYD15.MNU,P-ADV15.MNU,P-STAR15.MNU
and ACI5SBASE.MNU. SC15BASE.MNU is the startup menu,and AC15BASE.MNU is the same
as the regular AutoCAD menu except that under the *File* pull-down there are items for loading
SurvCADD modules. The other menus define the SurvCADD modules Cogo-Design, DTM-
Contour, Section-Profile, GIS, Mining, Hydrology, Advanced Mining, and Tsunami respectively.
These menus may be loaded by selecting the module name under the *Misc* pull-down menu. You
may also load these menus explicitly by issuing the AutoCAD MENU command and selecting the
desired MNU file from the SurvCADD support directory (eg. C\SCADXML\SUP).

Provided that the SurvCADD defaults have been set, SurvCADD commands may be executed once
aSurvCADD menuisloaded. The SurvCADD defaults are setby loading the SCAD.LSP file in the
SurvCADD LSP directory.

What is new in SurvCADD XML?

For a complete listing of the new features and additions in SurvCADD XML, visit our website at
http://www.carlsonsw.com
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Setting Up a Project in SurvCADD

Over 200 SurvCADD settings can be specified in the Configure SurvCADD command under the
File menu. These values are used to initialize SurvCADD options when opening a new or existing
drawing. Among these settings is the coordinate point number format, file and printer output
options and settings for each module.

Tosetthe AutoCAD drawing defaults, edit the template drawing (DWT file). This drawing is loaded
when new drawings are created. In the template drawing you can set the layers and AutoCAD
variables. For example you could create your standard layers and set variables as you like such as
BLIPMODE off. For SurvCADD, the drawing template should be set to ISSCDRAW from the
SurvCADD supdirectory (ie. C:\SCADXML\SUP\15SCDRAW.DWT). To customize the template,
run the AutoCAD OPEN command and choose the drawing template. In the Select File dialog, set
the type of file to Drawing Template (DWT) instead of regular drawings (DWG). Then make your
changes and SAVE the drawing as 15SCDRAW.DWT. Note: For SurvCADD in AutoCAD R4,
the default template drawing is 14SCDRAW.

When starting anew drawing, one of the first steps is to run Drawing Setup under the Ing-Set menu.
Drawing Setup sets the drawing scale, the unit mode as either English or metric, and the text, symbol
and linetype size scalers. The initial values for these Drawing Setup variables are set in Configure
SurvCADD. When a drawing is saved, the Drawing Setup variables are saved with the drawing.

In SurvCADD, the AutoCAD text style height should be set to zero. SurvCADD will set the text
height according to the drawing scale and text size scaler set in Drawing Setup. For example, if the
horizontal scaleis setto 50 and the text size scaleris 0.1, SurvCADD will draw the text with a height
of 5 (50 * 0.1). Then when the drawing is plotted at 1"=50', the text will be 0.1 inches. Use the
AutoCAD STYLE command to set the text style height to zero.

The Set Data Directory command in the File menu can be used to specify the directory for the project
data files. By default the drawing is stored in the SurvCADD WORK directory and the data files
are stored inthe DATA directory. The drawing file is the AutoCAD (.DWGQG) file. The data files are
the coordinate (.CRD) file, profile (.PRO) file, grid ((GRD) file and other SurvCADD data files. In
Configure SurvCADD|General Settings, there is an option to store all data files in the directory of
the drawing. With this option active all the files for the drawing
C:\SCADXML\WORKVOBS500,OB500.DWG would be stored in C:ASCADXMLAWORK\JOBS500.

Another level of file management is the automatic project file recall. Every drawing remembers the
datafiles thatare beingused for the drawing. When the drawing (DWG) file is saved withthe SAVE,
SAVEAS, or QSAVE command, SurvCADD writes a settings file that contains all the active data
filenames. Then when the drawing is reopened, the data files default to their previous settings. For
example, you won’t have to choose which coordinate file to use unless you want to change it. The
settings file is stored in the same directory as the drawing file and has the same name as the drawing
witha .INIextension. Forexample, adrawing survey.dwg would have a settings file called survey.ini.
You can turn offthe INI files with the Save Drawing INI Files option in Configure SurvCADD under
General Settings.
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Startup Wizard

For creating a new drawing in SurvCADD, the Startup Wizard can guide you through starting and
setting up the drawing. This wizard is optional and can be turned on or off in the Configure
SurvCADD->General Settings command. You can also exit out of the Startup Wizard at any time.

When the New drawing command is executed, you first get the standard AutoCAD choice of ““Start
from Scratch”, “Use a Template” or “Use a Wizard”. Typically, youwantto the “Usea Template”
option and choose the SurvCADD drawing template (SCDRAW 14 or SCDRAW15). The drawing
template will set of some basic drawing parameters such as defaultlayer names. After selecting the
AutoCAD new drawing option, the SurvCADD New Drawing Wizard dialog box opens.

The Startup Wizard begins

withadialogto setthe draw-

ingnameandscale. The first |~ e Drawing Hame
step to dois setthe drawing | [; 3&4le Settings
(.dwg) name by picking the % Englizsh 1in="1t
Set button. This brings up  Metic Tm=2m
the file selection dialog.
Change to the directory/ Horizontal Scale: 100.0

folder ("Save in" field) | SymbolPlotSize: Drawing Units:
where you want to store the Text Plat Size: IW‘ Drransing Urits: IW'
drawing. You can cither se- [~ Skip Startup “Wizard Mest Time

lect an existing folder or

create a new folder. To se- Hext | Eat | Help |
lect an existing folder, pull
down the Save in field to select a folder or drive, click the Move Up icon next to the Save in field
and/or the pick the foldername from the list. To create anew folder, pick the Create New Foldericon
to the right of the Save in field. Then type in the drawing name in the File name field and click the
Save button.

After setting the

|
drawing name, you el Bl bn : . 7]
can set the drawing =~ Savein |3 wiRK =« E’Q\' Gl' |
horizontal scale,sym- | [EH examplel dwa
bolsize, textsizeand | [Bf example2.dwg
unitmode (Englishor hydrnless;n.dwg Move up one folder Create New Folder

. . B8 mantapo.
Metric). Then click man oRa.g

e platd. dweg

the Next button.

The next startup dia-
log sets the Data Path
and CRD File. The
DataPathisthefolder = Saveastpe: |Drawing [*.dwg] =
where SurvCADD
willstorethe datafiles

File name: I
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such as raw (.RW5) files and profile (.PRO) files. The Set button for the Data Path allows you to
select an existing folder or create a new folder. See the Set Data Directory command for more
information. The coordinate (.CRD) File is the coordinate file for storing the point data. There is
an option to create a new or existing coordinate (.CRD) file. The new option will erase any point
data that is found in the specified CRD file. The existing option will retain any point data in the
specified coordinate (.CRD) file. Ifthe specified coordinate (.CRD) file does not exist, the wizard
will create anew file.

The next wizard step depends on the Import Points option. The Data Collector option will start the
datacollectionroutines to download data from a collector. The Text/ASCII option will import point
data from atext/ASClII file. See the Data Collection and Import Text/ASCII File commands for more
information on running these routines. If the None option is set, then the Startup Wizard is finished.

Once pointdata has been imported from the data collector or text/ ASCII file, the wizard guides you
through drawing the points. There are options to run Draw/Locate Points, Field To Finish or None.
If None is selected, then the Startup Wizard is finished. Draw/Locate Points will import the points
into the drawing using the same symbol and layer for all the points. From the Draw/Locate Points
dialog, set the symbol, layer and point attributes to draw (description, elevation) and then pick the
Draw Allbutton. The Field To Finish command will import the points into the drawing using different
layers and symbols depending on the point descriptions that refer to the code table defined in Field
to Finish. Also Field to Finish can draw linework. See the Draw/Locate Point and Field To Finish
commands for more information on running these routines. After drawing the points, the wizard
will zoom the display around the points. Then the wizard is finished.

Starfup Wizard Data Fles

Dt Path Set | e mohast, DL T,
CRDFia Sl | o mchaas DL T 5 iy ol
Coominmis Fie
T Pl & Exasing
Irngecit Foirks Froem
T Dts Colactnr = Test!43C1 Fla " Mo
Hex Eal ] Help |

Data Import Wizard I
360 points in CRO file
’—Draw Paints ...

& Draw/Locate Faints " Field ta Finish " Mane

I Riexd 1 Exit Help

Page 1-12 Installation & Overview



Layer and Style Defaults

Many SurvCADD commands have defaultlayers suchas AREATXT forarea labelsand BRGTXT
for bearing and distance annotations. These layers can be specified in dialogs for the correspond-
ing commands and several can be set in Configure SurvCADD. Sometimes you may want to use
the current layer and it can be an extra step to have to open the dialog to set the layer. In this case,
instead of using the default layer that set in the dialog, the default layer can be set as “CLAYER”
which will use the current layer. For example, if the annotation layer is set to CLAYER then
annotation will be drawn in the current layer instead of BRGTXT or whatever the annotation layer

used to be.
Annotate Defaults

This same concept applies for text styles. Several

commands have specific text styles and if you Horizontal Scale:
want to use the current style instead of the com- Anotation Layer
mand style, use thename "CSTYLE" for the style
name.
o
SurvCADD File Types
.ATR Strata attribute definitions
.CAL Mining equipment calendar
.CAP Capacity file for hydrology (stage-storage)
.CDT Mining custom date table
.CH Corchole definition
.CL Centerline file
.CQT Mining custom quantity table
.CRD Coordinate file (point#, northing, easting, elevation, description) in binary form
.DCL SurvCADD dialogs
.DEQ Drillhole equations
.DES Lot report for Lot Description command in COGO-Design
.DLL SurvCADD programs files
.DWG AutoCAD drawings
.EQO Mining equipment options
.EQU Mining equipment definitions
.EXE SurvCADD programs
.FLD Field to Finish code definitions
.FLT Triangulation mesh
.FRM Ferm Codes
.GEO Settings for Draw Geologic
.GFU Grid File Utilities macro command recorder file
.GIS GIS prompting definitions for note files
.GRD Grid file - a DTM surface model
.GSQ Grid sequence history file for mining
NI Program user preferences settings
HYD Watershed settings
.HZN Horizon code definitions
.LOT Lot file for COGO-Design
.LSP SurvCADD Lisp programs
LSQ Least-squares input data
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.MNC Compiled menus

.MNL SurvCADD Lisp programs for corresponding menu startup
.MNR Compiled menus

.MNS Compiled menus

.MNU SurvCADD source menus

MNX Compiled menus

.MPJ Mining project definitions

MXS Cross section alignment

NOT Note file - additional descriptions for points in corresponding .CRD file
.PAR Parameters for mining qualitiy compliance

.PLN Plan view polyline file for Dozer 2000

.PNA Mining panal attributes

.PRE Pre-calculated grids for strata model

.PRJ Project settings file

.PRO Profile (station, elevation, descriptions)

PTA Mining pit attributes

.RUN Auto-Run Strata Grids definition file

.RWS Raw file of traverse data

.SCR COGO script file

.SCT Cross section data (station, offset, elevation, descriptions)
.SEQ Dragline sequence file

.SEW Sewer network file for hydrology

.SLB Slide library

.SLD Slide image

STG Stage-discharge data for hydrology

.SUP Superelevation file

.TPC Template point centerline definition

.TPL Template file for Section-Profile

.TPP Template point profile definition

.TPT Template transition file for Section-Profile

VOL Auto-Run Strata Quantities definition file

Standard Report Viewer

Many SurvCADD routines display output in the Standard Report Viewer as shown below. The
report can be edited directly in the report viewer. Report Viewer commands are described below.

Open: This allows you to open an ASCII file and display the contents in the report viewer.
Save: Save the contents of the report viewer to a text file.

SaveAs: This allows you to save the contents of the report viewer to a file.

Append To: This allows you to append the contents of the report viewer to another file.

Print: Print the contents of the report viewer. This will open the standard windows Print dialog
where you can choose the printer and modify any of the printer settings before you actually print.

Screen: Draws the report in the current drawing. The program will prompt you for a starting point,
text height, rotation and layer.

Undo: Reverses the effect of your last action. If you mistakenly deleted some text, stop and choose
the Undo command to restore it. The key combination Ctrl-Z also performs this action.
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& SuryCADD Edit : c:AscademlAUSERAscadrprt_tmp

Eile Edit Settings

] (=
=(a|E —[J=s
Open | Save | Print | Exit Sereen | Hide

Profile Report |
C:\SCADEMLA\WORK\ street.pro

C:\SCADEMLA\WORE\ street?.pro
Generic Profile

First File:
Second File:

0570872002 13:00

Station Elevation Cut/Fill Distance Slope Description
0+00. 00 0,00 C 0O.00

0+40. 00 0.04 C 0O.00 40. 00 0O.10%
1+90.00 0.19 F 0.45 150.00 0O.10%
4+40. 00 -2.56 F 0.00 250.00 -1.10%
6+40. 00 -4.76 cC 0o.72 200. 00 -1.10%
9+40.00 -3.77 F 0.00 300. 00 0,33
11+40.00 -3.11 F 0.36 200. 00 0,33
21+90.00 =-7.10 F 0.00 1050.00 -0.38%
23+90.00 -7.686 C 0.29 200. 00 -0.38%
27+90.00 -7.06 F 0.00 400. 00 o, 20%

Select All: Selects all the text in the report viewer. [ 2 Fapast Viemm Ogtion: |
F bt pod st F Lkt deyes immk
Cut: Deletes the selected text and places itonthe & Lispaga rambar:
Windows® clipboard. LinarFagm 2
. . Lt waugn 2
Cf)py: Copies the selected text to the Windows® ¢ a—
clipboard. B AT -
Paste: Inserts ASCII text from the Windows® o o o o Flaatlii, .|
Clipboard into the report viewer at the cursor. EIRTERE s Hese TR Gninci Ford
Search: Opens the Find Text dialog. Allows you = | oL ]

to search for text in the report viewer.
Replace: Opens the Find and Replace Text dialog. Allows you to search for text and replace it.

Options: Opens the Report Viewer Options dialog. In this dialog, you can specify print settings,
such as lines per page and margins. You can also specify the font used in the report viewer. This
font is used for both the display and for printing.

Hide: This button allows you to minimize the report viewer window and give focus back to
AutoCAD. This allows you to return to working in AutoCAD without closing the report. You can
re-activate the report by picking on the minimized report viewer icon.
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Report Formatter Dialog

A number of SurvCADD routines use a Report Formatter Tool to allow you to specify how and
which results of calculations should be presented in the report. This report routine lets you select
a set of data to report and the format of the selected data. The report can be displayed in either the
standard viewer described in the previous section, Microsoft® Excel or Microsoft® Access.

The data setin the Report Formatter may be thought ofas a spreadsheet, where columns are various
fields related to a single item such as time period, drillhole, area and etc. Each new row represents
a new item. Descriptions of these field names are displayed in the Available list of the Report
Formatter. To include a data field in the report, highlight the field name in the Available list on the
left and pick the Add button. This moves the field name to the Used list on the right. The order of
items in the right list defines the order in which they will be displayed. In addition the items may
be sorted as specified by user in the right column. Items are first sorted by the first column, then
items with the same value in first column are sorted as specified for the second column and so on.

Report Formatting Options I

Format: PROD_BY PAMNEL §8 |PROD_BY_PANEL | Save | Delete |
Auwallable sed Sort order
Date Start = Pericd Up
Date Finish Panel Name Up
Equipment Gross Area Up
Work days Add > |COﬂL (tons) Up
Work hours Rock (tons) Up
Equip. time cost Remave < | Total tons Up
Section Key thickness Up
Owner
Gross Area, Acres =
bowve Up | hMowve Down |
[T Columnar farmat [T Use commas in numkbers St fied: e EE O EE
& Auto-wicth  Fixed width D
[ Tatals anly Total: IGrand j
Excel Export Options
& e = Open | | Select |
Sheet | | Start Row |1 | Caol |1 |
[ Include Totals Expart ta Excel |
Displany | Edit User Aftributes | Exportto Text File | Exit |
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These subsequent sortings do not modify sortings of previous columns. If you specify no sorting
for some column (even the first one) then no sorting will happen in subsequent columns either. For
example you may want to sort production by mining panel name, but not by month.

To generate the report after selecting columns and other preferences, click on Display button. It
will bring up a standard built-in viewer with the report. Upon exiting the viewer you come back into
the Report Formatter for further datamanipulation ifneeded. The other data output options include
saving the specified data into comma-delimited text file and direct export to Microsoft® Excel.

You may define new columns as equations based on existing columns. Click on the Edit User
Attributes button to add anew field name. A list of the existing attributes is available for reference.

User attributes may have one of the several summation options just like program-generated ones
(except that for them these options are set by program). The summation level is defined by the
"Total" pop-up list in the middle of the dialog. By default only grand total will be displayed at the
bottom of the list. By picking the next item in that box, you will get subtotals added each time the
value in first column is changed. It makes most sense to use this kind to summation if the
corresponding column is sorted. For example is first column is "Area Name" and it is sorted, and
"Total" is set to "Grand, Area Name" the report will have a sub-total for each distinct Area Name.
This feature makes the Report Formatter a very flexible tool for results exploration, even before or
without using a spreadsheet.

Various forms of reports may be saved and recalled using controls in the top line of the dialog.
To save a new version of the format, type in a new name (or use default to overwrite old one) and

User-Defined Attributes I

Ky Description Equation Repart

© meters  RREA/9.2903  yes Sum

Key: |AREASM | Desc: |AreEL 50. meters |

Equation |AREA;9-29U3 | I Reportad Decimals |2 |
Totals options:

’7('“ Ma tatal & Sum  Average by |Peri|:|d j

Update | Aol | Rermowve |

‘ Ok I List keys | Cancel |
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click on the Save button. The next time that you come to the Report Formatter from the same
SurvCADD routine it will recall this last format. To pick another format just pull down on list of
formats in the left top corner and pick which format to use. To Delete an unwanted format, pick it
from the list first and then click on Delete button.

There are several Microsoft® Excel export options provided. You may specify a spreadsheet file

to load before export, as well as a left upper cell to start with and sheet number to use. Totals which
are reported when using built-in viewer may be skipped when using Microsoft® Excel export.

Instruction Manual and Program
Conventions

\SRVM\SRVMENU Italic text in this font represent responses by the user that should
be typed in and followed by the [ENTER] key.

[Esc]  Text in brackets represent a key that should pressed for a prompt or command option.

[end on] Lower case text enclosed in brackets in Command prompts denotes an OSNAP mode
that is turned on by the command.

<90.0000> Values enclosed in corner brackets represent default values obtained by
pressing [Enter] with a blank response to AutoCAD or SurvCADD commands.

Number/<Pick point>: Text in this font represents prompts or questions that the computer
program will ask the user.

(pick point) Italic text in parentheses denotes a user response to a prompt such as
picking a point or a set of objects.

MENU  Text in this italic font represents AutoCAD or SurvCADD commands.
{SETUP} Text enclosed in braces represents screen menu selections.

*Display* Text enclosed in astericks represent pull-down menu selections.
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